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Copyright and acknowledgments
This guide is for Freeway 4 Pro.

Copyright © 1997-2005 Softpress Systems Ltd. All rights reserved.

The Freeway software and this documentation are copyright materials. 

No part of the Freeway software may be reproduced, transmitted, 

transcribed, stored in a retrieval system, or translated into any language, 

or computer language, in any form or by any means without the prior 

written permission of Softpress Systems Ltd. Additional copies of this 

guide may be made and distributed provided they include this copyright 

notice.

Softpress Systems Ltd specifically retains title to all Freeway computer 

software. The software described in this guide is furnished under 

a license agreement and may only be installed, used, or copied in 

accordance with the terms of that agreement.

Softpress is a trademark of Softpress Systems Ltd in the United States 

and other countries. Freeway is a trademark of Softpress Systems Ltd, 

which may be registered in some countries. 

Apple, Macintosh, Power Macintosh, and the Mac Logo are registered 

trademarks of Apple Computer Inc. All other product names are 

trademarks, or registered trademarks of their respective owners.

Limitation of liability

The information in this guide is believed to be correct as of the date of 

publication. However, our policy is one of continuous development and 

so the information in this guide is subject to change without notice, and 

does not represent a commitment on the part of Softpress Systems Ltd.

This guide was designed and produced by Human-Computer Interface Ltd,  

http://www.interface.co.uk/

Contact details 
You can reach Softpress Systems using the following contact details:

Softpress Systems Ltd 

First Floor 

25 Hanborough House 

Hanborough Business Park 

Witney, Oxon, OX29 8LH 

United Kingdom

Tel: (+44) 1993 882588 

Fax: (+44) 1993 883970

Web: http://www.softpress.com/ 

Email: info@softpress.com

Assumptions and conventions
To avoid ambiguity this guide adopts the following conventions:

Convention What it means

Bold Identifies a name or label that appears on the 

computer screen. For example: Click the OK button.

Computer Identifies text that you key in at the computer 

keyboard.

c, O, 

C, R

Represent the special keys on the keyboard: 

Control, Option (or Alt), Command, and Return.
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About the Freeway documentation
Freeway Reference

This Freeway Reference guide is aimed at more advanced Freeway users, 

and provides detailed reference information about advanced Web design 

features that may not be needed by all users. It also provides information 

about migrating from existing sites created in other Web programs, and 

a summary of the Freeway preference panels, palettes, and keyboard 

shortcuts. 

Getting Started with Freeway

The Getting Started with Freeway guide is the ideal place to start learning 

about how to get the most out of Freeway. It includes an overview of 

Freeway’s unique features and benefits, information about planning 

your site and publishing it on the Web, a guided tour of Freeway’s main 

features, and a series of three tutorials showing how to use Freeway to 

create stunning Web sites.

Using Freeway

The Using Freeway guide provides clear step-by-step instructions for using 

all the main features of Freeway, including setting up, previewing, and 

publishing a site, working with pages, text, graphics, tables, and forms, 

and creating dynamic effects. It is designed to help you translate your 

vision into a complete, fully working Web site. 

On-line Help

Freeway also includes a comprehensive integrated context-linked on-

line help system which you can use to find information about features 

while you are using the product. This includes the same information as 

provided in the Using Freeway and Freeway Reference guides.

The KnowledgeBase

The Softpress Web site also provides an advanced KnowledgeBase 

containing a wide range of information on every aspect of using Freeway, 

including technical notes on specific features, tutorials illustrating how to 

achieve particular effects, answers to frequently asked questions, and 

examples of sites created by third-party designers using Freeway. The 

knowledge base is fully searchable and is being extended on a weekly 

basis to provide answers to any question that users ask about Freeway. 
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This chapter describes the options in the 

Preferences dialog box you can use to customise 

the way Freeway works, and the document specific 

options in the Document Setup dialog box.
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Preferences
The options in the Preferences dialog box affect the working environment 

for all subsequent documents.

To display the Preferences dialog box

• Open the Freeway menu and choose Preferences….

• Click the appropriate icon in the icon bar to display the corresponding 

panel of preferences.

General

Provides general preference options.

The options are summarized in the following table:

Option Description

Arrows nudge Specifies the nudge distance for moving objects 

with the arrow keys.

Make backups Specifies whether Freeway makes a backup 

version of your document, with a .fwbackup 

extension, when you open the document.

Old selection 

behavior

Enables the behavior of selecting objects used 

in earlier versions of Freeway.

Enable 

AppleScript in 

Actions

Enables the ability to run AppleScripts in 

Freeway Actions.

Palettes snap Makes the Freeway palettes snap together 

automatically, to help maintain a tidy screen 

appearance.

Adjust box 

dimensions when 

adding padding

Changes the size of graphic and HTML items to 

keep the content the same size when adding 

padding.

Show help tags Shows a pop-up tag with help on toolbar icons 

and controls when you point to them with the 

mouse pointer.
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Text

Provides options that affect the appearance of text in the Freeway 

window:

Option Description

Minimum anti-

alias Size

Specifies a minimum size for applying smoothing 

to graphic text.

Invisibles color Specifies the color used to display invisible 

characters, such as spaces and carriage returns.

Appearance

Allows you to change the color used to identify each of the different item 

boxes:

Option Description

Graphic boxes Specifies the color used for the border of 

graphic items.

Table-positioned 

boxes

Specifies the color used for the border of HTML 

non-layer items.

CSS-positioned 

boxes

Specifies the color used for the border of HTML 

layer items.

Map area boxes Specifies the color used for the border of map 

area items.

Revert to default 

colors

Restores the colors to their default values.



P
references

4

Grids & Guides

Provides options relating to the guides and grid lines:

Option Description

Grid color Specifies the color used to display the grid 

lines.

Grid magnetic 

range 

Specifies the snap-to distance for grids, in 

pixels.

Horizontal/Vertical 

guide color

Specifies the colors used to display the 

horizontal and vertical ruler guides. Select Link 

to make the horizontal and vertical lines the 

same color.

Margin guide color Specifies the color used to display margins.

Guide magnetic 

range 

Specifies the snap-to distance for guides, in 

pixels.

To specify grids and margins for a master page or document page use 

the Grids… command on the Page menu.

Document setup
The options in the Document Setup dialog box allow you to control the 

settings for your current document and the output it generates when you 

publish the site.

To display the Document Setup dialog box

• Open the File menu and choose Document Setup….

• Click the appropriate tab to display the corresponding page of settings.

To change the settings for a particular document open the document and 

choose Document Setup….

To change the default settings that will apply when you create a new 

document, choose Document Setup… with no document open in 

Freeway.
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Document

Allows you to define the size of pages and the location of your Freeway 

document:

Option Description

Default page 

size

Specifies the default size of pages in your site. 

Choose one of the predefined page sizes from the 

pop-up menu, or choose Custom and specify the 

size explicitly in the Width and Height fields.

Width, Height Allow you to specify the page size explicitly.

Site folder Click the Select… button to specify the location 

of the Site folder, which will be used to contain 

the HTML and resource files when the site is 

published.

Option Description

Pasteboard 

width

Specifies how far the pasteboard extends in each 

direction outside the page area.

Document 

graphics 

Specifies the color depth for graphics saved with 

your Freeway document for preview: 

256 colors will give the smallest Freeway 

document size. 

Millions of colors will save the highest possible 

quality image with your Freeway document, allowing 

high-quality images to be generated when you 

publish your site if the original images are not 

available.
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Output

Provides options affecting the HTML generated and the naming of files 

created when you publish your site:

Option Description

Default HTML Specifies the default standard of HTML generated 

by Freeway. 

3.2 gives greatest compatibility with older Web 

browsers but does not support CSS.

4.01 is the recommended setting, and provides 

dynamic HTML and CSS support with all recent 

browsers.

XHTML 1.0 Transitional and XHTML 1.0 Strict 

generate XHTML-compliant code, for use with 

applications that require it.

HTML code Determines the formatting applied to the HTML 

generated by Freeway. Note that this option has no 

effect on the appearance of the page in a browser.

More Efficient leaves out optional white space to 

make the files as small as possible.

More Readable makes the HTML easier to read by 

indenting the output. 

Line feeds Macintosh, DOS, and UNIX use different linefeed 

characters. Selecting DOS or UNIX will allow the 

HTML text files to be read more easily on DOS/

UNIX systems. This doesn’t matter for browsers, 

but may be important for CGI scripts, etc.
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Option Description

Resources Specifies where the GIF images and other resource 

files are stored when the site is published. 

Common Resource Folder stores all the resources 

in a single folder.

Separate Resource Folders stores the resources 

for each folder in the site structure in a separate 

Resources folder at that level. 

With HTML Files stores the resources loose with 

the HTML files at each level.

File names Specifies the conventions used to generate the file 

names of HTML files and resources when the site 

is published.

Alphanumeric restricts the file names to letters 

and digits, as required by older servers.

DOS restricts the file names to 8.3 format for 

maximum compatibility with MS-DOS Web servers.

UNIX/Windows (recommended) generates file 

names suitable for UNIX or Windows servers.

Reinforce layout 

tables

Reinforces tables with invisible GIF images.

External 

Stylesheets

Stores CSS style sheets in a separate file from the 

HTML.

Set Browser 

Margin in HTML 

3.2

Sets a default margin of eight pixels at the top left-

hand side of the page, for consistency with older 

Netscape browsers that ignore the zero margin 

used by Freeway.

Option Description

Uppercase tags 

(not XHTML)

Specifies that the HTML tags should be generated 

in upper-case rather than the default lower-case. 

Not applicable to the XHTML output options.

Max. file name 

length 

Specifies the maximum length of automatically 

generated file names.

Image creator 

type

Specifies the creator type assigned to exported 

images. You can choose one of the following 

options from the pop-up menu: 

None specifies no creator type.

Other allows you to specify the four-letter creator 

type explicitly. 

Default Browser sets the image creator type to 

the default browser selected using the Preview 

Setup… command on the File menu. 

Choose Application… allows you to set the creator 

by selecting an application on your hard disk.
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Upload

Specifies the default upload method and settings used when the 

document is uploaded to the Web server using the Upload… command 

on the File menu:

For more information see the Using Freeway guide.

Text

Specifies the default encoding and language used for HTML generated 

when the site is published, and the default fonts used to display text in 

the Freeway document when editing the site:

Option Description

Default 

encoding

Choose Automatic to automatically set the 

encoding based on the text in the site, or select an 

encoding from the pop-up menu.

Spelling/

Hyphenation 

language

Specifies the language used for spelling and 

hyphenation.
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Option Description

Default fonts 

for encoding

Allows you to specify the font and size to use for 

displaying both standard and fixed width text in 

your Freeway document for each of the encodings 

you want to use. Select the encoding from the pop-

up menu, then specify the fonts and sizes using 

the Standard and Fixed-width menus below.

Graphics

Allows you to specify the default options for exporting GIF, PNG, and 

JPEG images:

Option Description

GIF/PNG Allows you to specify the default color palette, and 

whether the resulting images will be interlaced.

JPEG Allows you to specify whether JPEG images are 

made progressive, and the default compression/

quality level.

Apply bilinear 

scaling to 

images

Allows you to specify whether images will be 

scaled using bilinear filtering, which gives 

smoother results. This may be inappropriate for 

images containing line art.

Dither images 

with 256 or 

fewer colors

Automatically dithers images with fewer than 256 

colors to improve their quality.
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This chapter gives detailed information about the 

tools on the toolbar and the options on each of the 

Freeway palettes.
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Toolbar
The toolbar provides access to the tools you use for creating and editing 

items on your Freeway page:

To customize the toolbar

• On the View menu, choose Customize Toolbar….

• Drag items to and from the toolbar to customize the toolbar in the way 

that you want.

You can use the Separator, Space, and Flexible Space items to format 

the items on the toolbar.

When you have finished customizing the toolbar:

• Click the Done button.

To restore the default set of items 

• Drag the default set from the bottom of the Customize dialog box.

Modifier keys

Holding down certain keys on the keyboard while using any tool will alter 

the behavior of the tool until you release the key:

Modifier Description

O Temporarily changes any tool (except the Zoom tool) to 

a Grabber hand, allowing you to drag the page around 

within the window. Changes the Zoom tool from zoom in 

to zoom out.

C Temporarily changes to the Select tool, allowing you to 

select, deselect, or move items.

S c Temporarily changes to the Zoom tool.
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Tools
The tools allow you to create or manipulate the different types of item 

you work with in Freeway. 

The following table describes the function of each tool:

Standard tools

Tool Description What it does

Back/Forward Steps between recently visited 

pages.

Select tool Selects or manipulates items or 

edits text.

Zoom tool Zooms in and out of the Freeway 

window to change the scale of 

what you are working on.

CSS Layout Specifies whether new items 

added to the page use CSS layers 

or invisible tables (compatible with 

older browsers).

HTML Draws an HTML item on your 

page, to enter HTML text in your 

site.

Table Draws a table on your page, with 

a specified number of rows and 

columns.

Action Adds a Freeway action to the 

page. 

Tool Description What it does

Graphic Draws a rectangular graphic item 

on your page, to add a graphic 

image or GIF text.

Oval Draws a graphic item with an oval 

outline.

Map Area Draws rectangular clickable areas 

on images.

Rotate Rotates graphic items.

Flow tool Links two HTML or graphic items 

together so that text can flow 

between them.

Inspector Displays or hides the Inspector 

palette.
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Optional tools

These are available from submenus on the standard tools, or you can 

add them to the toolbar using the Customize Toolbar… option on the 

View menu.

Tool Description What it does

Separator Adds a dividing line to the toolbar.

Space Adds a space to the toolbar.

Flexible space Adds a space that right-aligns 

subsequent tools.

Customize Displays the Customize Toolbar 

dialog box.

Break Flow Unlinks HTML or graphic items 

that have been linked with the 

Flow tool.

Path Draws a graphic item with an 

arbitrary outline constructed from 

straight lines or smooth curves.

Button Adds a button to a form.

Checkbox Adds a checkbox to a form.

Tool Description What it does

Radio Adds a radio button to a form.

Text Field Adds a text field to a form.

Menu/List Adds a pop-up menu or list item 

to a form.

Text Area Adds a text area to a form.

Oval Map Area Creates an oval clickable area on 

an image.

Path Map Area Creates a clickable area with an 

arbitrary outline on an image.

Skew Skews graphic items.

Mirror Mirrors graphic items.

Styles & Colors Displays or hides the Styles and 

Colors palette.
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Palettes
Freeway provides the following palettes:

Palette Function

Inspector Displays options relevant to the currently selected 

item and allows you to edit them.

Styles and 

Colors

Displays the text styles and colors used in the 

document and allows you to edit or apply them, or 

select Web-safe colors.

Actions Shows the Freeway actions applied to an object and 

allows you to edit their parameters.

Frames Shows the structure of the currently selected 

frameset and allows you to edit the frames within it.

To display a palette

• Open the Window menu and choose the palette name.

To resize a palette

• Drag the resize box in the lower right corner. 

You cannot resize the Inspector palette.

To hide all the palettes

• Open the Window menu and choose Hide Palettes.

To edit a field on a palette

Either:

• Edit the value, then press R to confirm the change.

Or:

• Edit the value, then press T to confirm the change and move to the 

next field.

Inspector palette
The Inspector palette displays options relevant to the currently selected 

object.

When you have nothing selected on the page, the Inspector palette 

shows settings for the current page.

The following sections describe the most important panels in the 

Inspector palette and the options on each.
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Inspector palette – Page settings
The Page settings are shown when no items are selected on the page.

General page settings

Option Description

Title Sets the title of the page, which will appear as the 

window title when the page is viewed in a browser.

File Sets the file name that will be used to create the 

HTML when you publish the page.

W, H Specifies the width and height of the page.

Align Sets the alignment of the page items when the 

page is displayed in the browser window.

Master Sets the master page on which the current page is 

based, and allows you to apply a different master 

page.

StyleSheet Specifies the style sheet that applies to the current 

page.

Appearance settings

Background section

Option Description

Color Sets the background color for the page.

Image Allows you to select a background image for the 

page.

Horizontal, 

Vertical*

Can be set to Left, Center, or Right to specify 

the alignment of the background image, or Tile to 

repeat the image.

Background 

scrolls*

Specifies that the background image should scroll 

with the page.

* Only displayed with the HTML 4.01 or XHTML output settings and if a 

background image has been selected.
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Links section

Option Description

Normal, Active, 

Visited

Specifies the colors used for each type of link. 

The Normal link color is used for links on HTML 

text. The Active link color is displayed when the 

mouse is held down on a link, and the Visited 

link color is displayed when the user has visited 

a page. If no colors are specified, the browser 

defaults will be used.

Active, Hover, 

Link, Visited

Allows you to specify a CSS style for the 

corresponding state of link. The Active style is 

displayed when the mouse is held down on a link, 

the Hover style is displayed when the mouse rolls 

over a link, the Link style is the normal style, and 

the Visited style is displayed when the user has 

visited a page.

HTML generation settings

Option Description

HTML Specifies what type of HTML will be output for this 

page.

Code More Efficient creates compact HTML. More 

Readable creates formatted HTML that is easier 

to read.

Reinforce 

Layout

Includes padding characters in tables to keep their 

size more consistent when the browser window is 

scaled. Only available for XHTML.

Uppercase Tags Generates tags in upper-case instead of the default 

lower-case. Not applicable to the XHTML output 

options.

Encoding Sets the language encoding for the page.

Target Specifies a default target frame so that when 

someone clicks on a link on the current page it will 

be loaded into the frame you selected, and not the 

frame containing the link. See To specify the target 

for a link, page 63.
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Inspector palette – Item settings
The Item settings are shown when a single item is selected.

General settings

Properties section

Option Description

Title Sets the title of the item.

Layer Specifies that the item is positioned using 

CSS layers rather than invisible tables. When 

checked a pop-up menu allows you to select 

Absolute, to position the item relative to the 

page, or Fixed in Window, to position it relative 

to the browser window.

Lock Locks the item. Locked items cannot be moved, 

resized with the mouse, or deleted.

Show Shows the item. If unchecked the item will not 

appear in Freeway’s window, but will still be 

published.

Publish Specifies whether the item will be published.

Option Description

Combine Graphics/

Combine With 

Children*

Combines overlapping items (non-layer items) 

or items with child items (layer items) to create 

a single graphic when the site is published.

Background† Specifies the background color of the table.

* Graphic items only. 

† Table items only.

Dimensions section

Option Description

Left, Top* Sets the position of the item relative to the left-

hand edge and top of the page.

Width, Height* Sets the width and height of the item.

Right, Bottom* Sets the position of the item relative to the right-

hand edge and bottom of the page.

Padding Insets the content from the item. Select 

Custom… to set different insets for each side.
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Option Description

Wrap Defines a wrap margin for text in other items 

wrapping around this item. Select Custom… to 

set different margins for each side.

Wrap Wraps text in items below this item.

* Each of these measurements can either be defined in pixels (eg 110px) 

or as a percentage of the width of the page (eg 20%).

Dimension section (in-flow HTML items)

To insert an in-flow HTML item position the insertion point in an HTML 

item. Then open the Insert menu and choose HTML Item.

Option Description

W, H Specifies the dimensions of the in-flow item, 

in pixels or as a percentage of the size of the 

containing item.

Float Specifies how the item floats relative to the 

surrounding text. None specifies that no content 

can flow to the left or right of the item. Left allows 

content to wrap around the right of the item, and 

Right allows content to wrap around the left of 

the item.

Clear Allows you to control whether this item will flow 

around other in-flow items. None allows the item 

to flow normally, Left breaks the flow around Float 

Left items. Right breaks the flow around Float 

Right items, and Both breaks the flow around 

Float Left and Float Right items.

Padding Insets the content from the item. Select 

Custom… to set different insets for each side.

Margin Defines a wrap margin for content flowing around 

this item. Select Custom… to set different 

margins for each side.
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Dimensions section (in-flow graphic items)

To insert an in-flow graphic item position the insertion point in an HTML 

item or graphic item. Then open the Insert menu and choose Graphic 

Item.

Option Description

W, H Specifies the dimensions of the in-flow item, in 

pixels.

Align Specifies how the text aligns beside the in-flow 

item. The options are the standard CSS vertical-

align options: Top, Text Top, Super, Middle, 

Baseline, Sub, Text Bottom, and Bottom.

Padding Insets the content from the item. Select 

Custom… to set different insets for each side.

Margin Defines a wrap margin for text flowing around this 

item. Select Custom… to set different margins for 

each side.

Cells section (table items only)

 

Option Description

Rows Specifies the number of rows for the table. Rows 

will be added or removed from the bottom of the 

table.

Cols Specifies the number of columns. Columns will be 

added or removed from the right of the table.

Border Specifies the border width around the table.

Cell spacing Specifies the space between the cells.

Cell padding Specifies the space between a cell and its content.
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Screen Measurements section

Option Description

X, Y Position on screen.

W, H Dimensions on screen, adjusted for padding.

Other section (graphic items only)

 

Option Description

Shape The shape of the graphic item: Rectangle, Oval, 

or Path.

Corner Sets the corner radius for rectangular graphic 

items. Click the Custom… button to set a different 

radius for each corner.

First line 

leading

Sets the vertical position of the first line of text. 

Text direction Sets text to run horizontally or vertically.
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Appearance settings

Background section

Option Description

Color Sets the fill color of the item.

Opacity* Specifies the opacity of the graphic item. 

Filter* Applies the corresponding filter effect Emboss, 

Blur, or Scatter to the graphic item.

* Graphic items only.

Border section

Option Description

Color Specifies the border color.

Opacity* Specifies the opacity of the graphic item’s border. 

Size Specifies the border thickness.

Style/Dash Specifies the line style of the border.

Position* For a solid border, whether the border is outside, 

centered, or inside the graphic item.

Filter* Applies the corresponding filter effect Emboss, 

Blur, or Scatter to the border of the graphic item.

* Graphic items only.
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Shadow section (graphic items only)

Applies a drop shadow to a graphic item. The options are as follows:

Option Description

Color Specifies the color of the drop shadow.

Opacity Specifies the opacity of the drop shadow.

Angle Specifies the angle of the light source.

Global Specifies that this lighting effect should use the global 

lighting angle for the page.

Offset Specifies the offset of the drop shadow.

Blur Specifies the blur applied to the drop shadow.

Glow section (graphic items only)

Applies an outer glow to a graphic item. The options are as follows:

Option Description

Color Specifies the color of the glow.

Opacity Specifies the opacity of the glow.

Spread Specifies the distance the glow extends.

Blur Specifies the blur applied to the glow.

Foreground section (graphic items only)
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Applies a foreground color to a graphic item. The options are as follows:

Option Description

Color The foreground color, which will color text in 

graphic items below this item

Opacity The opacity of the foreground.

Shape Effect section – Crack (graphic items only)

Applies a crack effect. The options are as follows:

Option Description

Period The period of the cracks, from 0 to 100 pixels.

Random The randomness of the cracks, from 0 to 100%.

Gap The amount removed by the cracks, from 0 to 

100 pixels.

Depth The depth of the cracks, from 0 to 100 pixels.

Shape Effect section – Wobble (graphic items only)

Applies a wobble effect. The options are as follows:

Option Description

Period The period of the wobble, from 0 to 100 pixels.

Random The randomness of the wobble, from 0 to 100%.

Deviation The size of the wobble, from 0 to 100 pixels.

Smooth The smoothness of the wobble, from 0 (sharp) 

to 100% (smooth).
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Output settings

Provides options specific to the format in which the item is published.

HTML item (non-layer items)

Option Description

Width Can 

Grow

Specifies whether the item becomes wider as the 

browser window is made wider.

Height Can 

Shrink

Specifies whether the height of the item should 

shrink to fit the content if the text size in the 

browser is smaller.

Interlace GIF 

Files

Specifies whether inline GIF text in this item should 

be interlaced.

Anti-alias Specifies whether inline GIF text in this item should 

be anti-aliased, and if so, which color it should be 

anti-aliased against. Auto chooses the anti-alias 

color automatically based on the background 

color(s).

HTML item (layer items)

Option Description

Interlace GIF 

Files

Specifies whether inline GIF text in this item should 

be interlaced.

Overflow Specifies how the browser treats text that does not 

fit in the item. Visible allows the text to overflow 

the item, Hidden truncates the overflowing text, 

Scroll provides scrollbars on the item, and Auto 

provides scrollbars only when necessary to display 

all the text.

Anti-alias Specifies whether inline GIF text in this item should 

be anti-aliased, and if so, which color it should be 

anti-aliased against. Auto chooses the anti-alias 

color automatically based on the background 

color(s).



Tools and palettes

26

GIF item

Option Description

Size The size of the image in bytes. Only displayed if 

Preview Graphics is selected in the View menu, or 

if the graphic has been published.

Colors Specifies the color palette used for the image: 

Adaptive chooses the closest colors to those in 

the original image. 

Web 216 maps colors to the nearest colors in the 

Web-safe palette. 

Mac 256 maps colors to the nearest colors in the 

Macintosh system palette.

Colors slider Number of colors to be used for the image. GIF 

images can have a maximum of 256 colors. 

Reducing the number of colors can reduce the size 

of the resulting file.

Bilinear Scales graphics smoothly. May be inappropriate for 

some types of line art.

Option Description

Dither Uses patterns of pixels to give a closer match to 

the colors in the original image with the specified 

number of colors.

Interlaced Interlaced GIF graphics are displayed gradually 

as the file is downloaded by the browser. Your 

viewers see the image forming as they wait for the 

full file to download. This effect is off by default. 

Interlaced graphics may have slightly larger file 

sizes. To enable interlacing, tick the Interlace 

checkbox. The default for this option may be 

changed using the Document Setup dialog box.

Anti-alias Smooths the outlines of GIF text and box shapes. 

Choose Auto to smooth the outlines based on 

the fill color under the text, or select a color 

manually from the Anti-alias menu. You can 

specify a minimum text size for anti-aliasing in the 

Preferences dialog box.

Alt Text Specifies alternative text which will be displayed if 

the browser cannot display images, or the user has 

disabled them.

Submit Allows the item to be used as a Submit button 

on a form. When checked a Submit field appears 

which allows you to specify the value returned as 

the Name of the Submit button.
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JPEG item

Option Description

Size The size of the image in bytes. Only displayed if 

Preview Graphics is selected in the View menu, or 

if the graphic has been published.

Quality slider The quality, where 100% is highest quality and 1% 

is maximum compression giving the smallest file 

size.

Bilinear Scales graphics smoothly. May be inappropriate for 

some types of line art.

Progressive Makes the JPEG display gradually as the file is 

downloaded.

Anti-alias Smooths the outlines of text and box shapes. 

However, JPEG format is not recommended for text.

Alt Text Specifies alternative text which will be displayed if 

the browser cannot display images, or the user has 

disabled them.

Submit Allows the item to be used as a Submit button on 

a form. The Submit field will be returned as the 

Name of the Submit button.

PNG item
The PNG options are identical to those available for GIF images, except 

that Millions is an additional option on the Colors menu.

URL item
An item set to be a URL item takes its content from an external file when 

viewed over the Web.

Option Description

Content Specifies whether the content of the item is an 

image or is provided by a Server Side Include.

URL Specifies the URL for the external content.
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Option Description

Alt Text Specifies alternative text which will be displayed if 

the browser cannot display images, or the user has 

disabled them.

Submit Specifies that the item should act as a submit 

button for a form.

Map area item

Option Description

Alt Text Specifies alternative text which will be displayed if 

the browser cannot display images, or the user has 

disabled them.

Inspector palette – Text settings
The Text settings are shown when text is selected in an HTML item or 

graphic item.

Character and Paragraph settings – HTML text

Character section

Specifies the character formatting for HTML text.

Option Description

Type Selects either HTML or GIF output for a selection 

of text.

Font Selects from the available font sets or allows you 

to create a new one.

Color Sets the text foreground color. Equivalent to 

the Color option on the Text section of the text 

appearance settings.

Style Selects bold, italic, underline, strikethrough, 

overline, or blink. Overline is only available for the 

HTML 4.01 and XHTML output options.

Size Specifies the text size.

Shift Applies HTML super- or subscripts.
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Paragraph section

Specifies the paragraph formatting for HTML text.

Option Description

Type Specifies either HTML or GIF output.

Align Sets HTML paragraphs to be left-aligned, centered, 

right-aligned, or justified. 

List Specifies ordered (where list items are preceded 

by numbers or letters) and unordered (where list 

items are preceded by bullets and so on) list 

styles.

First-line 

indent, Left 

indent, Right 

indent*

Specifies indents for the paragraph.

* With the HTML 3.2 output option this changes to Indent with options 

None or 1 to 5.

Rule section
Shown when a horizontal rule is selected in an item:

To insert a rule, position the insertion point in an HTML item or graphic 

item. Then open the Insert menu and choose Rule.

Option Description

Align Specifies the alignment of the rule within the item.

Size Specifies the thickness of the rule.

Inset Specifies the rule’s inset from the enclosing item.

Solid Rule Specifies whether the rule will be solid or three-

dimensional.
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Character and Paragraph settings – GIF text

Character section

Specifies the character formatting for GIF text.

Option Description

Font Selects a font from all available fonts on your 

system.

Color Sets the text foreground color. Equivalent to 

the Color option on the Text section of the text 

appearance settings.

Style Specifies bold, italic, underline, word underline, 

outline and shadow.

Size Allows you to select a size from the pop-up menu 

or enter a size explicitly.

Space Sets the spacing between characters.

Paragraph section

Specifies the paragraph formatting for GIF text.

Option Description

Align Sets GIF paragraphs to be left-, center- or right-

aligned, or justified or force-justified.

Leading Sets the leading as a percentage or absolute size 

in pixels.

Indent Sets the first line indent, right indent, and left 

indent.
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Appearance settings

Shape Effect section – Crack effect (GIF text only)

Adds a crack or corroded effect to the text. The following controls allow 

you to adjust the parameters of the crack effect:

Option Description

Period The period of the cracks, from 0 to 100%.

Random The randomness of the cracks, from 0 to 100%.

Gap The amount removed by the cracks, from 0 to 

100%.

Depth The depth of the cracks, from 0 to 100%.

Shape Effect section – Wobble effect (GIF text only)

Adds a wobble or irregularity to the outline of the text. Provides the 

following parameters:

Option Description

Period The period of the wobble, from 0 to 100%.

Random The randomness of the wobble, from 0 to 100%.

Deviation The size of the wobble, from 0 to 100%.

Smooth The smoothness of the wobble, from 0 (sharp) 

to 100% (smooth).
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Shadow section (GIF text only)

Provides the following controls:

Option Description

Color Specifies the color of the drop shadow.

Opacity Specifies the opacity of the drop shadow.

Angle Specifies the angle of the light source.

Global Specifies that this lighting effect should use the 

global lighting angle for the page.

Offset Specifies the offset of the drop shadow in pixels 

or as a percentage.

Blur A number between 0 and 20 to specify the 

degree of blur of the drop shadow.

Glow section (GIF text only)

Provides the following parameters to allow you to control the outer glow:

Option Description

Color The color of the outer glow.

Opacity The opacity of the glow.

Spread The spread of the glow between 0 and 10.

Blur The degree of blur of the glow, between 0 and 

20.
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Background section

Specifies the background color of the text. The following parameters are 

provided:

Option Description

Color The background color.

Opacity* The opacity of the background.

* GIF text only.

Text section

Option Description

Color Specifies the text color.

Opacity* Specifies the text opacity.

Draw* Specifies the drawing style for text: Draw solid, 

Draw border only, or Draw solid and thicken. For 

the Draw border only and Draw solid and thicken 

options a pop-up menu allows you to specify the 

thickness of the border, in points.

Filter* Applies an Emboss, Blur, or Scatter filter effect to 

the text; see the following sections.

* GIF text only.
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Emboss filter

Provides the following additional controls to allow you to control the 

Emboss effect:

Option Description

Angle, Altitude Specifies the angle and altitude of the light 

source for the Emboss effect.

Global Specifies that this lighting effect should use the 

global lighting angle for the page.

Specular Controls the percentage of specular highlight. 

Higher values make the object look smooth and 

shiny.

Diffuse Specifies the percentage of diffuse lighting. 

Higher values make the object look rough or 

matte.

Blur filter

The following additional controls allow you to adjust the blur effect:

Option Description

Blur The size of the blur, between 0 and 20.
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Scatter filter

The following control allows you to adjust the radius of the scatter:

Option Description

Radius A number between 0 and 20 to determine how far 

each pixel on the outline of the text is scattered.

Overlay section

The Overlay section allows you to create a second layer of text above 

the main layer with different Draw, Color, Opacity, and Filter settings, to 

achieve a variety of two-color effects.

Option Description

Color Specifies the color of the overlay.

Opacity Specifies the opacity of the overlay.

Draw Specifies the drawing style for the overlay: Draw 

solid, Draw border, or Draw solid and thicken. 

For the Draw border and Draw solid and thicken 

options a pop-up menu allows you to specify the 

thickness of the border in points.

Filter Applies a filter effect to the overlay layer. The 

options are the same as for the Text section 

filter effect options.
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Font features

The font features section provides access to selected OpenType font 

features in the currently selected font. This section is only available for 

OpenType fonts.

The actual options provided depend on the features supported by the 

currently selected font, but will typically include some or all of the 

following:

Feature Description

Ligatures Substitutes special ligature characters for the 

corresponding pair of letters: eg “Fi”.

Letter Case Allows you to select all capitals or small capitals.

Number Spacing Allows you to choose between monospaced (fixed 

width) numbers and proportional numbers.

Smart Swashes Allows you to select individual swash characters.

Vertical Position Allows you to specify superscript or subscript 

text.

Character 

Alternates

Selects alternate versions for certain characters.

Feature Description

Style Options Selects alternative style options included with 

the font.

Number Case Selects between lowercase (old style) numbers 

and uppercase (lining) numbers

Inspector palette – Table cell settings
Shown when one or more table cells are selected in a table.

Table cell settings

Current Row section

Option Description

H Specifies the height of the current row.

Extend… Allows you to add attributes to the table row <tr> 

tag.

Markup… Allows you to add HTML markup before and after 

the row.
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Current Column section

Option Description

W Specifies the width of the current column.

Table Cell section

Option Description

W Specifies the width of the selected cell.

H Specifies the height of the selected cell.

Align Specifies the vertical alignment within the cell.

Color Specifies the color of the cell background.

Option Description

Empty Specifies whether the cell will be left empty in the 

published table.

Extend… Allows you to add attributes to the cell <td> tag.

Inspector palette – Frameset settings
The Frameset settings are shown when the current page is a frame-

based page.

Frameset settings

General section

Option Description

Title Specifies the frameset title. This will appear as the 

window title in the browser.

File Sets the frameset file name.

Border Specifies the width of the border between frames.
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Current Frameset section
Shown when a frame is selected.

Option Description

Vertical Specifies whether the frameset is horizontally or 

vertically oriented.

Size* Allows you to set the size of the frameset; either 

fixed or percentage.

* Only for child framesets

Current Frame section
Shown when a frame is selected.

The Current Frame section relates to the selected frame.

Option Description

Name Specifies the name of the frame; used when 

targeting links to this frame.

Source Specifies the page that will load initially in the 

frame.

Scroll Specifies whether scroll bars should appear in the 

browser. Yes always displays scrollbars, No never 

displays scrollbars, and Auto displays scrollbars 

when necessary to allow the user to scroll the 

content.

No Resize Check this to prevent the user from resizing the 

frame by dragging the border.

Size Specifies the size of the frame, either fixed or as a 

percentage.
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Inspector palette – Form item settings
These sections are displayed when one of the form items is selected. 

The item output settings panel changes depending on the type of form 

item.

Checkbox

Option Description

Name The name of the form item.

Value The value returned when the item is checked in the 

browser.

Text The label for the checkbox.

Checked Whether the checkbox is initially checked in the 

browser.

Radio Button

Option Description

Name The name of the radio button cluster. Selecting this 

button in the browser will deselect all other buttons 

with the same name.

Value The value returned when this radio button is 

selected.

Text The label of the radio button.

Checked Whether this radio button is selected by default in 

the browser.
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Button

Option Description

Name The name of the button.

Value The label shown on the button. If omitted, a default 

label is shown.

Type Submit to submit a form, Reset to clear a form, or 

Button for a button with no action.

Text Field

Option Description

Name The name of the field.

Value The text to be displayed by default.

Password Specifies that the content of the field should be 

hidden for password use.

Maximum 

length

The maximum number of characters to be allowed 

in the field.

Size The width of the field.
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Menu/List

Option Description

Name The name of the field.

Size The number of choices in the menu or list. Set to 1 

for a pop-up menu.

Multiple If selected, the user can choose multiple items 

from the list.

Choice/Value A list of choice names and their associated values. 

Double-click an item to edit it. Click the Page icon 

below the list to add a new choice. Click the Trash 

icon below the list to delete the currently selected 

choice. Click A or V below the list to change the 

order of items.

Text Area

Option Description

Name The name of the text area.

Text Default text to be displayed in the text area.

Wrap Whether the text can wrap in the text area.

Rows Specifies the number of rows of text in the text 

area.

Columns Specifies the number of columns in each row.
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Styles and Colors palette
The Styles and Colors palette provides three panels: the Document 

styles panel, the Document colors panel, and the Web-safe colors panel.

The Options button displays a pop-up menu of options relevant to the 

currently selected panel.

Document styles panel

Shows a list of permanent and temporary styles in the document:

You can create a new permanent style using the New Style… command 

on the options pop-up menu.

Permanent styles
Permanent styles are shown in bold in the palette. They remain defined 

even if unused in the document.

Temporary styles
Temporary styles are shown in plain text, and are created automatically 

as you edit text in the document.

Paragraph styles
Paragraph styles are distinguished from character styles in the palette 

with a “¶” paragraph symbol in front of their name.

Document colors panel

Shows the colors in use in the document, plus a small set of default 

colors.

You can create a new color using the New Color… command on the 

options pop-up menu.

Permanent colors
Colors shown in bold type are permanent colors, which remain defined 

even if unused in the document. 

Temporary colors
Colors in plain text are temporary colors, which are only listed if they are 

currently applied to an object. 

Clicking a color applies it to the attribute specified by the Apply to pop-up 

menu at the top of the palette.
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Web-safe colors panel 

Shows the 216 Web-safe colors and allows you to select one:

Frames palette

Shows the structure of any framesets defined for the current page and 

provides an options pop-up menu of commands for working with HTML 

framesets. 

The buttons along the top of the palette allow you to delete a frameset, 

add a frameset, or add a new frame.

Actions palette
Allows you to set the parameters for actions.

When multiple actions have been applied to an item or a page, each 

action will appear as a tabbed panel within the palette when the item or 

page is selected. For more information about using actions see Using 

actions in the Using Freeway guide.
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This chapter describes advanced options for 

working with HTML in Freeway, including: importing 

HTML files, flexible items, font sets, and linking 

HTML items and graphic Items.
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Importing existing HTML and text files
Freeway can import existing HTML pages, preserving as much of the 

contents and formatting of the original as possible. However, because 

Freeway does not work directly in HTML you may need to do further 

editing and layout work after importing the HTML pages.

To import an HTML page into an existing document

• Open the File menu and choose Get HTML….

• Locate the HTML file you wish to import and click the Open button.

Freeway will create a new page in your document, based on the default 

settings in Document Setup, and import the contents of the HTML file.

To import a folder of HTML pages into an existing 
document

• Open the File menu and choose Get HTML….

• Select an HTML file in the folder containing the HTML files you wish to 

import and click the Import button:

Freeway will create new pages in your document based on the default 

settings in Document Setup and import the contents of the HTML files.

To convert an HTML file by drag and drop

• Drag and drop the HTML file you wish to convert onto the Freeway icon 

in the Finder or Dock.

Freeway will create a new document based on the default settings in 

Document Setup, and import the contents of the HTML file into HTML 

items on the page.

To drag text from another application

• Select the text you wish to import.

• Drag it and drop it onto a Freeway page, to create a new HTML item, 

or onto an existing item, to insert the text in the item.

Flexible items
Normally HTML items and graphic items have a fixed size and position on 

the page, and remain fixed if the user changes the size of the browser 

window.

Freeway provides two options to allow you to create flexible items that 

change relative to the size of the browser window. 

Layer items
The recommended option if you are using the HTML 4.01 or XHTML 

export options, is to define the item as a layer item, in which case it 

uses CSS-based layout to specify the size and position of the item. 

With layer items you can define any of the dimensions as a percentage 

relative to the browser window, instead of as an absolute value in pixels.
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Non-layer items
Non-layer items use table-based layout to position the item on the page. 

You can make non-layer HTML items flexible horizontally, so they expand 

depending on the size of the browser window, and/or flexible vertically, 

so they adjust to accommodate the content.

To define an item as a layer item

• Select the item.

• Click the general settings icon at the top of the Inspector palette to 

display the item general settings.

• In the Properties section select Layer.

• Choose Absolute from the Layer pop-up window to position the item 

relative to the top left corner of the page, or Fixed in Window to 

position the item relative to the top left corner of the browser window:

Note that Fixed in Window may not give consistent results in different 

Web browsers.

To make the dimensions of a layer item flexible

• Specify the appropriate dimensions as a percentage in the Dimensions 

section of the Inspector palette:

To specify the overflow behavior for layer HTML 
items

• Select the item.

• Make sure Layer is checked on the item general settings panel of the 

Inspector palette.

• Click the output settings icon at the top of the Inspector palette to 

display the item output settings.

The Overflow pop-up menu provides four options for determining what 

happens when the content overflows the HTML item in the Web browser:
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The options are explained in the following table:

Option Description

Visible The content is allowed to overflow and is visible 

below the item.

Hidden The content is truncated to the size of the item.

Scroll The item always displays a vertical scrollbar to 

allow the user to scroll the content into view.

Auto The item only displays a vertical scrollbar if the 

content overflows.

To make the width of a non-layer HTML item flexible

• Click the output settings icon at the top of the Inspector palette to 

display the item output settings.

• Select Width Can Grow:

When the page is output, the HTML item will expand in proportion to the 

width of the browser window.

To make the height of a non-layer HTML item flexible

• Click the output settings icon at the top of the Inspector palette to 

display the item output settings.

• Select Height Can Shrink:

When the page is output, the height of the HTML item will adjust to fit 

the content within it.

Font sets
When you apply a font in HTML, the actual font must be present on 

the visitor’s machine in order for the text to display as intended. 

Unfortunately, even the names of the standard fonts vary across different 

computing platforms.

Font sets solve this problem by allowing you to define a series of 

alternative font names, which the Web browser attempts to use to display 

the text. The browser will check each font listed in the set from left to 

right until it finds one present on the visitor’s computer. If it cannot find a 

match, the browser’s default font will be used.

Freeway provides the following default font sets: Courier, Georgia, 

Helvetica, Symbol, Times, Trebuchet MS, and Verdana. You can edit 

these, or define new font sets, using the Font Sets dialog box.
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To define a new font set

• Open the Edit menu and choose Font Sets…:

• In the Edit Font Sets dialog box click the New… button.

• Specify a name for the new set. 

This name will appear in the HTML Font pop-up menu in the Inspector 

palette, and in the style menus.

• Choose a screen font. 

The screen font will be used within Freeway to display text that has this 

font set applied to it. The font is automatically added to the list of font 

names below.

• Enter a list of additional font names you wish to use, separated by 

commas, in the order you wish them to be used:

• Click the OK button to save the font set.

To edit a font set

• In the Edit Font Sets dialog box select the font set and click the 

Edit… button.

To delete a font set

• In the Edit Font Sets dialog box select the font set and click the 

Delete button.
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Linking HTML or graphic items
Freeway allows you to link two or more HTML items or graphic items, so 

that text automatically flows between the items when you are editing the 

page.

Note that the text flow is only active while you are editing the Freeway 

document. When you publish the site the text is broken into separate 

blocks.

When you select linked items, a red arrow shows the text flow:

You can select text across linked items in the usual way, by dragging or 

by choosing Select All from the Edit menu.

To link two or more items

• Select the Flow tool.

 

• Click the first item and then each subsequent item in the same order 

that you want text to flow through them.

Text placed in the first item will flow through the linked items until all the 

text is placed.

To unlink items

• Select the Break Flow tool.

 

• Click one of the linked items to display the links.

• Click the red line linking the items.

The item pointed to by the link is removed from the flow of text and text 

reflows into the item that was before the removed item. 

If it is an HTML item, it will resize vertically to contain the new text. 

If it is a graphic item, it will display an overflow icon in the bottom left 

corner to show that there is more text in the box than can be displayed.

To delete a text box from the text flow

• Select the box using the Select tool, and delete it.

Text will reflow into the remaining text boxes.

To cut a linked text box

Cutting a text box from a linked chain is the same as deleting it; the text 

will reflow into the remaining text boxes.
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To insert a break to the next linked text box 

You can insert a break to flow the text from where you currently are to 

the next box in the flow. 

• Position the cursor where you would like the break to begin.

• Open the Insert menu and choose Break, or type Ce.
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This chapter discusses the pros and cons of using 

frame-based pages in your Web site, and describes 

the features in Freeway for creating frame-

based pages, designing and editing frames, and 

controlling the content in frames.
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What are frames?
Frames are an extension to HTML to allow several different documents 

to be displayed in separate autonomous subwindows inside the Web 

browser window. Without frames, the browser displays one Web page 

filling the whole window, and if the page is too large to fit in the window 

scroll bars are displayed to allow the user to view the content. When you 

link to another page the whole window is updated with the contents of 

that page. 

With a frame-based page the Web browser window is divided up into 

separate areas, called frames, and these behave like independent 

windows. If the content is too big to fit in one of the frames, scroll bars 

can be displayed to allow the visitor to scroll that frame independently of 

the rest of the Web browser window. Clicking on a link in one frame can 

cause the content to be updated in that frame, or to replace the content 

in any of the other frames.

How do frames work?

The way that frame-based pages work is actually conceptually quite 

simple. 

When the visitor connects to a frame-based page they load a frameset 

definition that tells the browser how to divide up the window into 

separate frames. It also tells the browser what content to load into each 

frame, and gives information about the property of each frame, such as 

whether it can scroll and whether the user can change its size. 

From then onwards, the browser behaves as if each frame is a separate 

independent browser window. In addition, there are some minor 

extensions to standard HTML to allow the content in one frame to affect 

the content in a different frame.

What are frames used for?

The most common use of frames is to provide static navigation bars 

which remain visible even when the main text of the page is scrolled or 

changed. 

For example, a frame-based page allows the designer to place buttons 

along the top of the page, links in a bar to the left of the page, or both of 

these features at the same time, with the main area being scrollable by 

the user:



W
or

ki
ng

 w
ith

 f
ra

m
es

55

Why are frames no longer 
recommended?
Most current Web designers and Web standards frown on the use of 

frames. The main reason is that many of the benefits of using frames 

have been superseded by other more standard extensions to HTML, 

including dynamic HTML and cascading style sheets. In addition, tools 

like Freeway make it easy to create sites with consistent navigation bars 

on every page, using master pages, further reducing the benefit of using 

frames.

Disadvantages of using frames

The main disadvantages of using frames are as follows:

Disadvantage Explanation

Search engines Search engines like Google usually index each 

frame of a frame-based page separately, so 

that when you link to the page containing the 

search term you see just the frame containing 

the search term rather than the full frame-based 

page.

Printing Most current Web browsers can only print one 

frame of a frame-based page, so users cannot 

keep a printed copy of the whole page.

Bookmarking 

URLs

Because a frame-based page is displaying 

content from two or more URLs simultaneously, 

there is no way of bookmarking the page so you 

can return to view exactly the same content at a 

later date. 

Disadvantage Explanation

Accessibility 

problems

Frame-based pages can cause problems for 

visitors with visual disabilities, because many 

tools designed to help such users do not work 

with frame-based pages.

Browser history The Back and Forward buttons in the browser 

can work strangely with frame-based pages.

Despite these disadvantages, many sites continue to use frame-based 

pages, and browsers will almost certainly continue to support them. 

Freeway includes support for frame-based page design, and in fact 

makes it far easier to design frame-based pages than other packages.
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Designing with frames
The easiest way to create a frame-based page in Freeway is to select 

from a range of predefined layouts. A new frameset page will be created 

in your document, together with a blank page to contain the content for 

each of the frames. 

Alternatively you can convert any page in a Freeway document into a 

frameset page with two or more frames using the Split Horizontal or Split 

Vertical commands.

To create a predefined frameset page

• Open the Page menu and choose New Frameset… from the Frames 

submenu.

The New Frameset dialog box shows 16 alternative predefined frame 

layouts:

• Choose a title for the frameset page.

• Choose the master to use for the frameset page, and a border width.

• Click the picture corresponding to the frame layout you want to use.

If you want to create a page for each of the frames in the New Frameset 

page:

• Select Create Pages for Frames.

• Choose the master you want to use for these pages from the Master 

pop-up menu.

• Click the OK button to create the frameset you have specified. 

For example, if you created a frameset with a top navigation bar, a 

left-hand bar, and main area, Freeway will create a frameset page with a 

frameset icon and three contents pages called upper, left, and main:
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Using the Frames palette
The Frames palette provides a convenient way of seeing the structure of 

a frameset. It shows how the framesets on the page are nested, and the 

orientation and number of frames within each frameset.

If a frame is currently selected it is shown in dark gray in the Frames 

palette:

If an object is selected in a particular frame, that frame is shown with 

gray diagonal hatching:

The icons along the top of the Frames palette allow you to delete the 

currently selected frame, add a new frameset page, and add a new frame 

to the current frameset. In addition the Options pop-up menu provides a 

selection of additional options for working with frames.

Editing frame-based pages
When you make a frameset page the current page in the Site panel, 

Freeway shows you the layout of the frameset with the initial content in 

each frame:
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You can either choose to edit in this view, or you can select one of the 

individual pages in the Site panel, such as upper, left, or main, and edit 

the content on that page:

To specify the source for a frame

• Select the frame by clicking it in the Freeway window.

The frame will be highlighted with a gray border:

• Click the frameset icon at the top of the Inspector palette to show the 

frameset settings.

• Click the > to the left of the Current Frame heading to show the 

current frame settings.

• Choose the document you want to specify as the source from the 

Source pop-up menu:
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To specify an external HTML page as the frame 
source

• Proceed as above, then choose Other… from the Source pop-up menu:

The Frame Source dialog box shows the existing frame source and allows 

you to specify an alternative internal or external source:

• Click the External tab and enter the URL of the external HTML page:

To define content to be displayed if the visitor 
cannot view frames

Each frameset page allows you to provide a page which will be displayed 

if the visitor’s browser doesn’t support frames. Usually this feature is 

used to display a message advising your visitor to use a more up-to-date 

browser.

• Select the frameset page in the Site panel.

• Click the Noframes button at the bottom right corner of the Freeway 

window.
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You can then edit the content displayed for the page if frames are not 

supported:
Specifying the layout of a frame-based 
page
The frameset page allows you to specify the layout and behavior of the 

frames in the frameset, including:

• Whether there is a border between frames, and if so, its width. 

• Whether frames are fixed width/height, or change in proportion to the 

size of the browser window.

• Whether scroll bars are displayed if the content of the frame will not fit 

within its current size.

• Whether a frame can be resized by the visitor.

To specify the width or height of a frame.

Either:

• In the Freeway window, position the mouse pointer on the border 

between two frames until it changes to a resize symbol.

• Drag to resize the frame.

Or:

• Click the frame in the frameset window to select it.

• Click the frameset icon at the top of the Inspector palette to show the 

frameset settings.

• Click the > to the left of the Current Frame heading to display the 

current frame section.
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• Edit the size in the Size box:

• Click the px button to specify the size as a fixed width or height in 

pixels, or the % button to specify the size as a percentage of the width 

or height of the browser window.

To make the frame fill the browser window

A typical requirement is to make the top navigation bar and side address 

bar both have fixed sizes, and make the size of the main frame flexible 

so it expands to fill the browser window.

• Set the size of the upper and left frames to fixed values.

• Select the main frame and uncheck the Size checkbox:

The main frame will now expand to fill the browser window.

To specify how the frame scrolls

• Click the frameset icon at the top of the Inspector palette to show the 

frameset settings.

• In the Current Frame section choose the appropriate option from the 

Scroll pop-up menu:

The following options are available:

Option Description

Auto Displays scroll bars only when necessary to 

display the content. 

Yes Always displays scroll bars even if the content 

fits.

No Never displays scroll bars, even if the content 

does not fit.
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To specify a border between frames

• Select the frameset.

• Click the frameset icon at the top of the Inspector palette to show the 

frameset settings.

• In the General section edit the value in the border field:

The frames will be displayed with the border you specified.

To create a new frameset within a frame

This technique is necessary when adding frames of a different orientation 

from the other frames in the window.

• Select the frame by clicking inside it.

The frame will be highlighted with a gray border.

• Open the Page menu and choose Split Vertical or Split Horizontal 

from the Frames submenu.

A nested frameset will be created in the frame, dividing the frame into 

two parts. Each of the two new frames can either be given a source 

page or subdivided further using the Split Horizontal or Split Vertical 

command.

To add more frames at the same level

• Select one of the existing frames.

• Open the Page menu, choose Frames, then choose Insert Frame… 

from the submenu, or click the Add Frame icon in the Frames palette:

A dialog box allows you to choose where the new frame is to be inserted:

• Specify the position for the new frame and click the OK button.

A new frame is added to the same frameset as the selected frame.

To add frames by dragging

Either:

• Hold down O and drag the dividing border between two frames in 

the same frameset to add a new frame at the same level.

Or:

• Hold down O and drag the border between a frame and the edge of 

the window to add a new frame in the same frameset, or create a new 

frame in the enclosing frameset.
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To change the orientation of the frames in the 
frameset

• Select the frameset, or a frame within it.

• Click the frameset icon at the top of the Inspector palette to show the 

frameset settings.

• Click the > to the left of the Current Frameset heading:

• Select the Vertical checkbox to specify that the frame should be 

vertical or uncheck it to make the frame horizontal.

To remove a frame

• Select the frame.

Either:

• Open the Page menu, choose Frames, then choose Delete Frame from 

the submenu.

Or:

• Press b or d.

Or:

• Click the Delete icon in the Frames palette.

The selected frame will be deleted.

If you attempt to delete one of the only two remaining frames defined for 

a frameset page, Freeway will display a dialog box asking you to confirm 

your choice:

• Click the OK button to delete the frameset altogether and revert the 

page from a frameset page to a normal page.

Creating links in frame-based pages
When your visitor clicks a hyperlink on a frame-based page the usual 

behavior is for the destination page to replace the contents of the frame 

containing the link with the contents of any other frames remaining 

unchanged.

Alternatively you can set a target for the hyperlink to cause the 

destination to be displayed in a different frameset within the same 

frameset page, replace the content of the entire browser window, or be 

displayed in a completely new browser window.

To specify the target for a link

• Select the text or graphic item that you want to convert into a 

hyperlink.

• Open the Edit menu and choose Hyperlink….

The Edit Hyperlink dialog box will be displayed to allow you to specify the 

destination of the hyperlink and the target option.

• Specify the destination for the hyperlink in the usual way.
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• Specify the target for the hyperlink by choosing the appropriate option 

from the Target drop-down menu.

• To make the destination of the link appear in a specified frame in the 

frameset select the name of the frame from the Target drop-down 

menu:

• Alternatively choose one of the following predefined link targets:

Target Description

_parent Displays the destination page in the frameset 

containing the frame in which the link occurs. If 

there is only one frameset this is the same as 

the _top option.

_top Displays the destination page in the whole 

browser window.

_blank Displays the destination page in a new browser 

window.

_self Displays the destination page in the frame 

containing the link. This is the default behavior.

To set the base target for a page

You can set the default target for all links on a specified page to avoid 

the need to specify each link’s target individually.

• Click the HTML generation settings icon at the top of the Inspector 

palette to display the HTML generation settings for the page:

• Choose the appropriate option from the Target drop-down menu.



This chapter describes the features Freeway 

provides to enable you to insert specific HTML 
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Including meta tags
Meta tags are sections of HTML added to a page that provide additional 

information about the content on the page. They do not affect the 

appearance of the page in a Web browser, but provide information about 

the page for use by search engines and other automatic internet-based 

tools.

The most common meta tags provide the following features:

Meta tag name Description

DESCRIPTION A description of the page.

KEYWORDS A list of keywords related to the page.

GENERATOR The name of the software used to create the 

site.

REFRESH Loads another page automatically.

To add a meta tag

• Open the Page menu and choose Meta Tags….

The Meta Tags dialog box shows a list of the meta tags already defined, 

and allows you to edit them or define new tags:

By default Freeway provides you with a GENERATOR meta tag with the 

value Freeway Pro.

To define a new meta tag

• Click the New… button in the Meta Tags dialog box.

You are prompted to enter the name and value for the tag.

• Enter the appropriate meta tag name in the Name field, and type the 

value in the Value field:
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• Click the OK button to add the meta tag.

The meta tag will be displayed in the Meta Tags dialog box:

To edit or delete a meta tag

• Select the meta tag in the Meta Tags dialog box.

• Click the Edit… or Delete button.

To load another page automatically

The Meta Tags dialog box also allows you to define system meta tags. 

The most useful of these is the REFRESH tag which causes the Web 

browser to reload the page after a certain delay, or load a different page 

automatically.

• Open the Page menu and choose Meta Tags….

• In the Meta Tags dialog box click the System (HTTP-EQUIV) button to 

display the System meta tags.

• Click the New… button and type REFRESH in the Name field.

• In the Value field type the value. For example:

5;URL=newpage.html

where 5 is the number of seconds to wait before redirection takes place, 

and newpage.html is the URL of the destination page:

Adding custom HTML to your site
Freeway provides several options for adding specific custom HTML to 

your site. All these methods allow you to add HTML code via the Freeway 

user interface, and you do not need to edit the HTML directly. The HTML 

you have added is stored as part of your site, and is automatically 

integrated with the HTML generated by Freeway each time you publish or 

preview your site.

Freeway provides the following methods for adding HTML code to your 

site:

• Add code to a specific page.

• Extend the code generated for specific objects.

• Reference external content when the page is viewed.

• Insert code at a specific point on a page.

• Import external HTML into a document. 

• Use a Freeway action.

These options are described in greater detail in the following sections.

Note: Take care when adding your own HTML to a site. Errors can go 

unnoticed but may interfere with the correct appearance or operation of 

the site.
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To add HTML code to a page

• Open the Page menu and choose HTML Markup….

• Choose an option from the Insert pop-up menu to specify where you 

want to add the code in the page.

You can enter a separate snippet of code for each of the options on the 

Insert menu.

Options for which you have defined code are shown underlined in the 

menu:

• Click the OK button to add the HTML.

For example, to add JavaScript code to the page you will typically add it 

to the section Before </HEAD>. This ensures that it is processed before 

the body or page content is loaded.

To extend the code generated for specific objects 

Freeway provides an Extended command at several places in the user 

interface to allow you to add additional parameters to the HTML tag 

associated with the object you have selected on the page.

The following table lists the different contexts in which you can use the 

Extended command:

Context What it affects

Page menu The <body> tag on the current page.

Hyperlink dialog box The <a> tag.

Item menu for a graphic 

item

The <img> tag.

Item menu for a 

multimedia item

The <embed> tag.

Item menu for a table The <table> tag.

• Select the item you want to extend, or no item to affect the current 

page.

• Open the Page or Item menu and choose Extended….
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The following dialog box allows you to define name/value pairs to be 

added to the appropriate HTML tag:

• Click the New… button to add a tag and enter the name and value 

that you want to insert:

• Click the OK button to add the name/value pair.

• Click the OK button to close the Extended Attributes dialog box.

The above example adds a parameter to the <body> tag:

<body OnLoad="alert('Please register')">

When the page is loaded into a browser this will cause a JavaScript alert 

to be displayed:

Referencing external content
Freeway allows you to include content in your site that is provided 

from an external location. An example might be an advertising banner, 

a counter that records how many visitors viewed your page, or text 

providing the latest news supplied by an external feed.

To reference external content in a URL item

• Click the HTML icon in the toolbar and draw a box to contain the 

external content.

• Click the output settings icon at the top of the Inspector palette to 

display the item output settings and choose URL from the Type pop-up 

menu.
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• Set the Content to Image to display an external image file, or HTML to 

include a snippet of HTML using a server side include, and enter the 

URL of the external content in the URL box:

• To supply alt text for the image select Alt Text and type the text into 

the corresponding box.

When you specify a URL item with Content set to Image, the URL you 

specify is inserted into the Freeway output inside an <img> tag; for 

example:

<img src="/cgi-bin/counter.cgi"border=0>

When you specify a URL item with Content set to HTML, the URL 

you specify is inserted into the Freeway output inside a #include 

statement; for example:

<!- - #include virtual="included.inc"- ->

Note: Referencing external HTML using a #include tag only works when 

the page is served by a Web server which supports server side includes. 

Check with your ISP whether this option is available on your server.

To insert code at a specific point on a page

• Open the Insert menu and choose Markup Item….

The following dialog box allows you to specify the HTML code to be 

inserted on the page:

• Enter the code to be inserted and click the OK button.

A markup item will be displayed on the page:

You can move and resize the markup item as required on the page. The 

code contained in the markup item will be inserted in the page at the 

point corresponding to the item’s location on the page.
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To add an inline markup item

• Insert the text insertion point in an HTML item where you want to add 

the markup item.

• Open the Insert menu and choose Markup Item….

An icon will displayed to indicate the position of the markup item:

• To edit the HTML code double-click the icon.

To import HTML content into an HTML item

If you have a standard section of HTML that you want to include in an 

existing page you can import an HTML text file into an HTML item.

• Select the HTML item (do not position the insertion point in the item):

• Open the File menu and choose Import…. 

• Select the file containing the snippet of HTML and click the Open 

button.

The imported HTML cannot be displayed or edited within Freeway, but it 

will be inserted when the page is previewed or published. For example, 

you might keep a standard copyright message on disk as an HTML file 

and include this on each page of your site in an HTML box:

When the site is published the latest version of the copyright text will be 

incorporated in each page of the site.
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This chapter describes the shortcut keys available 

in Freeway.
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Freeway menu
Shortcut Command

Command , Preferences…

Command H Hide Freeway Pro

Command Option H Hide Others

Command Q Quit Freeway Pro

File menu
Shortcut Command

Command N New…

Command O Open…

Command Option O Open Backup…

Command W Close

Command Option W Close All

Command S Save

Command Shift S Save As…

Command E Import Text…/Import…

Command Option E Export…

Command P Publish Site

Command Control P Publish Everything

Command Option B Preview (in default browser)

Command U Upload…

Edit menu
Shortcut Command

Command Z Undo

Command X Cut

Command C Copy

Command Option C Copy Content

Command Shift Option C Copy as Picture (externalize the 

clipboard)

Command V Paste

Command B Clear Content

Command A Select All

Command K Hyperlink…

Command Shift Option K Follow Link…/Check Link…

Command Shift A Anchor…

Command F Find…

Command G Find Next

Command Shift G Find Previous

Command Control H Find Selection

Command Shift Control H Find Previous Selection

Command R Replace…

Command T Replace Next

Command Shift T Replace Previous

Command L Spelling…
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Page menu
Shortcut Command

Command Option N New Pages…

Command Option F Form Setup…

Item menu
Shortcut Command

Command Option T Transform…

Command Option Shift M Modify…/Modify Text…

Command Option X Extended…

Command Option L Lock

Command Shift Option L Unlock

Command = Bring To Front

Command - Send To Back

Command / Align to Grid

Command Option G Group/Ungroup

Command Y Align…

Command T Distribute…

Command D Duplicate…

Command Shift K Graphic: Original Size

Command Shift D Graphic: Fit Box to Graphic

Command Shift M Graphic: Center

Shortcut Command

Command Shift F Graphic: Scale to Box

Command Shift Option F Graphic: Scale and Pad

Command Shift Option . Graphic: Scale Up

Command Shift Option , Graphic: Scale Down

Command Backspace Table: Join Cells

Style menu
Shortcut Command

Command Shift \ Size: Other…

Command Shift . Size: Next Size

Command Shift , Size: Previous Size

Command Shift Option . Size: Grow Size

Command Shift Option , Size: Shrink Size

Command Shift P Type Style: Plain

Command Shift B Type Style: Bold

Command Shift I Type Style: Italic

Command Shift U Type Style: Underline

Command Shift W Type Style: Word Underline

Command Shift O Type Style: Outline

Command Shift Option \ Width: Other…

Command Shift 9 Width: Increase Width by 5%

Command Shift 0 Width: Decrease Width by 5%
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Shortcut Command

Command Option Shift 9 Width: Increase Width by 1%

Command Option Shift 0 Width: Decrease Width by 1%

Command Shift ] Spacing: Increase Spacing by 5%

Command Shift [ Spacing: Decrease Spacing by 5%

Command Shift Option ] Spacing: Increase Spacing by 1%

Command Shift Option [ Spacing: Decrease Spacing by 1%

Command Shift = Baseline: Raise baseline by 5%

Command Shift - Baseline: Lower baseline by 5%

Command Shift Option = Baseline: Raise baseline by 1%

Command Shift Option - Baseline: Lower baseline by 1%

Command Shift L Alignment: Left

Command Shift C Alignment: Center

Command Shift R Alignment: Right

Command Shift J Alignment: Justified

Command Shift Option J Alignment: Forced

Command Shift E Leading: Other…

Command Shift ‘ Leading: Increase Leading by 1px 

or 10%

Command Shift ; Leading: Decrease Leading by 1px 

or 10%

Command Shift Option ‘ Leading: Increase Leading by 

1/10th px or 1%

Command Shift Option ; Leading: Decrease Leading (by 

1/10th px or 1%

Insert menu
Shortcut Command

Command Enter Break (to next box in text flow)

Shift Return New Line

Command Shift Return Rule

View menu
Shortcut Command

Command Option Z Zoom…

Command 1 Actual Size

Command 0 Fit in Window

Command Shift Option I Invisibles

Command Shift Option O Outlines

Command Shift Option T Titles

Command Shift Option G Guides

Command Shift Option P Graphics Preview

Command Shift Option H HTML Layout

Command [ Back

Command ] Forward

Command Option M Master page

Command Option P Preview in Freeway

Command Option R Hide/Show Rulers

Command Option S Hide/Show Site panel



K
ey

bo
ar

d 
sh

or
tc

ut
s 

77

Window menu
Shortcut Command

Command Shift N New Window

Command Option I Inspector

Command Option Y Styles and Colors

Command Option A Actions

Command Shift H Show/Hide palettes

Selecting and editing text
Shortcut Command

Return Place text cursor in selected box

Shift Right arrow Highlight next character

Shift Left arrow Highlight previous character

Shift Down arrow Highlight to next line

Shift Up arrow Highlight to previous line

Option Shift Right arrow Highlight text to the beginning of 

next word

Option Shift Left arrow Highlight text to the beginning of 

previous word

Option Shift Down arrow Highlight text to the beginning of 

next paragraph

Option Shift Up arrow Highlight text to the beginning of the 

paragraph

Option Right arrow Moves to the beginning of next word

Shortcut Command

Option Left arrow Moves to the beginning of previous 

word

Option Down arrow Moves to end of paragraph

Option Up arrow Moves to beginning of paragraph

Command Left arrow Moves to beginning of line

Command Right arrow Moves to end of line

Command Up arrow Moves to beginning of text box

Command Down arrow Moves to end of text box

Shift Backspace Delete next character

Items
Shortcut Command

Hold Shift then draw Constrain box shape to square/

circle

Start drawing and then hold 

Option

Draw from the center

Arrow keys Move box by nudge distance

Option Arrow keys Move box by 1/10 nudge distance 

(minimum 1 pixel)

Shift Arrow keys Resize box in direction of arrow by 

nudge distance

Shift Option Arrow keys Resize box in direction of arrow by 

1/10 nudge distance (minimum 1 

pixel)
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Shortcut Command

Drag handle and Shift Constrain shape of box to square/

circle

Drag handle and Option Shift Constrain proportions of box (and 

scale graphic content)

Command Shift D Fit box to graphic

Shift drag Move with horizontal and vertical 

constraints

Start drag with Select tool and 

then hold Option

Move and clone box

Start drag with Rotate tool and 

then hold Option

Rotate and clone box

Start drag with Skew tool and 

then hold Option

Skew and clone box

Start drag with Mirror tool and 

then hold Option

Mirror and clone box

Shift click box Add box to selection

Graphics
Shortcut Command

Command Option T Display Transform dialog

Command Shift K Restore graphic to original size

Command Shift D Fit box to graphic

Command Shift M Center graphic in box

Command Shift F Scale graphic exactly to box

Command Shift Option F Scale graphic to box maintaining 

proportions

Command Shift Option . Increase scaling of contents of box 

by 5%

Command Shift Option , Decrease scaling of contents of box 

by 5%

Start resizing box and then 

hold Control

Temporarily set graphic behavior to 

Preserve Size

Start resizing box and then 

hold Command

Temporarily set graphic behavior to 

Scale

Start resizing box and then 

hold Command Option

Temporarily set graphic behavior to 

Scale and Pad

Start resizing box and then 

hold Option

Temporarily set graphic behavior to 

Scale and Trim
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Tables
Shortcut Command

Command Click on cell Select a cell

Command Option Click on an 

already selected cell

Select a table

Command Click anywhere on 

table and begin dragging

Move a table

Select a cell; Command Shift 

Click another cell; then type 

Command Backspace

Join cells

Point to the border between 

two rows or columns so cursor 

changes to the resizing shape; 

Drag to the desired size

Resize a row or column (affects 

overall table size)

With resizing shape, Command 

drag the border between two 

rows or columns

Resize a row or column (overall 

table size will not change)

With resizing shape, Option 

drag the border between two 

rows or columns

Insert a row or column

Command B Clear contents of selected cells

Dialog boxes and palettes
Shortcut Command

Return or Enter OK in dialog box

Escape Cancel in dialog box

Tab Highlight next field in dialog box/

palette

Shift Tab Highlight previous field in dialog 

box/palette

Command click on color in 

palette

Displays Color dialog box

Command click on highlighted 

style in Styles and Colors 

palette

Removes the style from the 

currently selected text or item

Option click on style name in 

Styles and Colors palette

Edit style name

Option click on name in Site 

panel

Edit name

Option click on color name in 

Styles and Colors palette

Edit color name

Command Control Tab Show tools palette and select next 

tool

Command Control Shift Tab Show tools palette and select 

previous tool
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Zoom control
Shortcut Command

Control Shift click or Control 

Shift drag

Zoom in

Control Shift Option click Zoom out

Special text characters
Shortcut Command

Option - En dash

Shift Option - Em dash

Option Space Non-breaking space

Option [ “

Shift Option [ ”

Option ] ‘

Shift Option ] ’

General
Shortcut Command

Control click an object Displays a pop-up contextual 

menu of commands relating to the 

object.
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